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Introduction

About the Demo

How to use this tutorial:

The tutorial contains a guided debug session. It uses a simple C-program example to show you the most 
important debug features. 

When the simulator is started a script file that sets up a debug session is automatically executed. The script 
file can also be started by using the Batchfile command in the File menu.

You should perform a number of exercises as you read this tutorial. We recommend to go completely 
through all chapters, since besides the tour (written in normal text format) there are very helpful remarks 
(written in italics) which will not be repeated in other chapters.

How long does it take?

30 minutes.
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The User Interface

TRACE32 uses several windows to display the information the user requests. One of the most important 
aspects of the application is the code view. The command Data.List will display the disassembled/
decompiled code in an own window. According to our startup script “start.cmm” in the section Building 
Batch Jobs we loaded the application and instructed TRACE32 to display the source code in a Data.List 
window .

If you do not see the souce code (in the Data.List window) because you have used a different startup script, 
you may open it by the command “Data.List” in the command line or the menu item “List Source” in the 
View menu. Both methods are displayed in the screenshot below.

The gray bar indicates the current position of the program counter. Rigth now it is located on the main adress 
symbol. This is because it was instructed in the startup script, as follows:

; set window position and display Data.List window

WinPOS 0% 0% 100% 100%

Data.List

; set cpu register 

Register.Set pc main

program counter

open and display
source window
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The most functions of TRACE32 can alternatively be selected in three ways:

1. from a pulldown menu

2. from a button in the main tool bar 

3. from the command line. 

Please refer to the previous screenshots and remember it, even if we mostly use the command line in the 
following chapters.

The TRACE32 commands are not case sensitive. In the TRACE32 books we use upper case letters for the 
characters that are significant for the command entry. E.g. Register.view can be shortened by r or R. 
Another example which shows the typical TRACE32 command structure 
<command family>.<subcommand> is Data.List that can be shortened to d.l no mater wether it‘s 
lower case or upper case.

A good hint is to look at the soft keys. They provide a guided command entry. All possible commands and 
parameters are displayed. Instead of writing to the command line you can assemble the correct command 
by clicking on the soft keys. 
Example: Assembly of the Data.dump command by using the softkeys.

Soft Keys
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Regardless of the method a command was initiated (button, menu or in the command line), TRACE32 
displays the command that was executed in the window title.

Working with the menu, softkey or buttons in the tool bar may be helpful in figuring out the command .
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Display and Modify Memory

To inspect an address range in the memory use the Data.dump window as seen in the previous section.  
Type in the command data.dump <adress range> or select  

• Select Dump… from the View menu.

• Push the icon in the toolbar.

• Type in the command Data.dump. 

Next a dialog will be opened. Fill in data item to display in the following dialog box. Use the Browse button 
to browse through the symbol data base. Select a label by a double-click and then confirm by pushing 
OK. If using the command in the command line, you may also specify an adress or symbol directly.      

The  data will be displayed in an own window.  It‘s title  reflects the calling method an parameter. 

To get HLL-information 
select HLL and push 
browse-button
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In the following screenshot it was called by a command in the command line. .  

There are different display options and ways to define an address range:

• <start address>--<end address>

• <start address>++<offset>

The value at a memory address can be modified by a double click. A Data.Set command for the selected 
address is displayed in the command line. Enter the new value and confirm it with return..

Memory Class + Address Hex-Value ASCII-Value
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Debug the Program

Open the Data.List window by using List Source in the View menu. The program listing around the 
program counter is displayed. 

Single step through the program by clicking one of the following: 

• the Step menu option in the Run menu

• <F2> (as noted in the step menu option in the Run menu)

• the Step button in the toolbar

• the Step button in the Data.List window

• the Step command entered in the command line 
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Now have a look at the state line: The address of the current cursor position (gray bar in active window) is 
displayed there. 

The next field displays the state of the debugger: stopped means your application program is stopped. You 
can now for example inspect or change memory. . 

Depending on the startup script which was used, the display of the code will be either HLL ( High Level 
Language) only or  a MIXed mode with HLL and it‘s corresponding assembler mnemonic. The debug mode 
field in the state line indicates, which mode is used. Pushing the mode button on top of the Data List 
windows will change the mnemonic to HLL and vice verca. The state line always shows the debug mode 
HLL or MIX.

(symbolic) address at the cursor position          state of debugger        debug mode

Toggle debug modeLocal buttons for the Data.List window
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.

Toggle the debug mode to HLL and do another Step. The step you did was a high level language step to the 
next HLL line. If you switch to MIX mode and push the step key, it will execute one assembler line.
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Select a code line and press the right mouse button. If you select Go Till  the program execution is started. It 
stops when the program reaches the selected code line.
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Single Stepping is one of the basic debugging commands. Look at the Run pulldown menu, at the local 
buttons of the Data.List window or at the main tool bar for the other debug commands.

Step over function call or subroutines.
Go to the next code line written in the program listing.

Go Return / Go to the last instruction 

Useful e.g. to leave loops of a function.

Step Over

Single Step

Break / Stop realtime execution

Go / Start realtime execution

Go Up / return to the caller function
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For the following example, assume we have a nesting of functions where main calls func2() and func2 calls 
func1(). 

The Var.Frame window displays the function nesting for your application program. With the option LOCAL 
the local variables of each function are displayed. When the option CALLER is set, a few lines from the C-
code are displayed to indicate where the function was called. The following screen corresponds with the 
nesting and calling sequemce as mentioned above..

TRACE32-ICD provides also more complex debug control commands. You can run or step until an expression 
changes or becomes true. Example: Var.Step.Till j>9 single steps the program until the variable j 
becomes greater than 9. 
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How to Set Breakpoints

Breakpoints

Back to the program. Doubleclick on the code line where you want to set a program breakpoint. Be aware to 
click the white space in the code line, and not the code literal. All code lines to which a program breakpoint is 
set are marked with a small red bar. 

Use List from the Breakpoint menu to display the information about all breakpoints.
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The format of the Break List is as follows

4. Column 1: hex address of breakpoint.

5. Column 2: type of the breakpoint.

6. Column 3: indicates  how breakpoint is realized - as SOFTware, ONCHIP or DISABLED. A gray
bar in Data.List indicates a DISABLED breakpoint

7. Column 4: code line of breakpoint. E.g. func2\6 means HLL-line 6 in func2. func2\13+0x8 means
HLL-line 13 in func2 plus 8 bytes (useful in display mode MIX only).
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Start the program execution with Go. If the program does not reach your breakpoint, you can stop the 
program execution with Break.

You can remove the breakpoint by another doubleclick to the marked line or by toggling the breakpoint in the 
Break.List window. 
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To set a program breakpoint to a code line, that is not displayed yet, select Show Function… in the Var 
menu. Double click the function to display it and then set the breakpoint by a doubleclick to the code line. 

The second breakpoint type is a spot breakpoint. A spot breakpoint is a watchpoint, that stops the program 
execution for a short time to update all displayed information and then restarts the program execution.

Double Click

Double Click
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To set a spot breakpoint, select the code line where it makes sense, that the displayed information is 
updated. Press the right mouse button and select Spotpoint from the pulldown menu.

Set 
Spotpoint
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To watch for example all changes on the variable primz, select the variable by the mouse, press the right 
mouse button and apply Add to Watch Window from the pulldown menu.

8. Assign a breakpoint in func2a and func2b.
 Check breakpoints by doing a Break.List.

If you now start the program execution with Go, 
you can watch the changes on the variable primz.
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Display and Modify HLL Variables

To display HLL variables use the Watch command from the Var pulldown menu. 

Select the variable by a double click 
from the symbol database

The selected variable is displayed at the 
top of the Watch Window

Every time you use Watch from the
Var menu, the new variable is added 
to the top of the window. Resize the 
window to see all entries in the Watch
Window. 
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A quicker way to look at a variable is to mark the variable in the Data.List window by the cursor and to press 
the right mouse button. From the Var pulldown menu select Add to Watch Window. 

If you want to display a more complex structure or an array in a separate window use View… in the Var 
pulldown menu.

If you just want to watch all variables accessed by the current program context use 
Show Current Vars from the Var pulldown menu and execute a few single steps.

 

In most windows a context sensitive menu can be used with the right mouse button. If you select a variable 
you get access to the Var pulldown menu, that provides all features for displaying and modifying variables.
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You want to inspect a variable and you are not sure about the spelling open the symbol browser to display all 
symbols stored in the internal symbol database.

If you want to modify a variable value, double click to the value. The appropriate Var.set command will be 
displayed in the command line. Enter the new value and confirm with return.

Double Click on func2
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Format HLL-Variables

To adapt the display of a variable to your need, select the variable name, press the right mouse and select 
Format… from the Var pulldown menu.

If you display more complex HLL structures, select TREE in the Format field of the Change Variable 
Format dialog box. This formatting allows to select the display for each member of the structure by clicking 
on + or -.

Select Type to display the
variable with the complete
type information
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Exit TRACE32

Besides that, To exit from TRACE32-ICD use Exit in the File menu.  
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